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1. Oligo 7 Installation

1.1. Installation

Oligo software can be installed only if you have administrator privilages for this
particular computer. If you cannot save files to the Program Files or Applications
Folder you need to log out and log-in with the account that has administrator
privileages or ask your IT manager to install Oligo for you.

1.1.1. Installation form the Internet

Download the zipped Oligo package, Oligo7Mac_Installer.zip (Macintosh), or
Oligo7Win_Installer.zip (Windows) to your hard drive. Some systems unpack the
files automatically, and some require manual unzipping. Double click on the zip
file to unpack the contents.

Double click on the Oligo7Mac_Setup installer package (Mac; sometimes you
see the ".pkg" at the end of the name), or on the Oligo7Win_Setup (PC;
sometimes you see the ".exe" at the end of the name) to start the installation
process, and follow the on-screen instructions. In Macintosh, Oligo is installed in
Oligo sub-folder in the Applications folder. In PC, the default folder is C:\Program
Files\Oligo 7. Start Oligo 7, fill out the registration form and register it, as
described in Chapter 1.2.

1.1.2. Installing OLIGO from a Compact Disk

To load the OLIGO program to your hard drive:

1. Insert the Oligo 7 Disk into computer's CD drive.
2. Mac: double click on Oligo7Mac_Setup.pkg installer package, and follow the
instructions displayed on screen.

PC: Double click on the Oligo7Win_Setup.exe icon displayed in the CD
drive window. Follow the on screen instructions. You would be asked for the
folder name and location of the Oligo 7 application.

3. Once the installation is complete, double click on the Oligo 7 icon to start it
and register your program license. Alternatively you can start Oligo by
choosing "Start" from the desktop, followed by "Programs".

1.2. Registration

In order to protect your copy of the OLIGO program and provide you with prompt
technical support, we need you to register as an OLIGO user with your distributor
prior to accessing OLIGO or seeking technical support.

The registration form takes a few minutes to complete and you should receive
your access code within an hour after contacting your distributor during normal
business hours.



Because each installation creates a unique workstation code, you will need to
register each computer separately.

To register your OLIGO software on each computer, follow these steps:

1. Double-click on the OLIGO icon to call up the registration procedures.

2. Once the "Customer Registration" window appears, complete each field.
Use either the mouse or <Tab> to move to each field. This window must be
completed for each workstation you are registering (See the figure below)
Your e-mail address must be entered to make the “Register” button active.
The Fax number must be entered to get the “Print” button active. Leave the
Access Code field blank.

800 OLIGO 7 Customer Registration

Welcome to OLIGO 7 Primer Analysis Software. In order to protect your program
license, and provide you with prompt technical support, please complete this
customer registration form and click "Register” button. If you are not connected
to the Internet, please Print and fax this formto +1 719 684 7989. After this,
you may Exit Oligo, and when you receive the Access Code back from us, you

N\ may re-start Oligo, enter the Code and click the "Confirm Code" button.
The registration would then be completed for this particular computer.

Principal Investigator or Manager's Name:

Institution and Department:

Address:
Phone Number: Ext.: Fax Number: E-Mail:
License #: Workstation Code: Access Code:
8729 5978 5949
(Print Setup) K Exit J Print Save Register Confirm Code

The OLIGO Customer Registration window.
Note: Your software license number is on the OLIGO CD, User Manual or/and in the e-

mail conformation of the purchase.

3. When you enter the license number the “Register” button should become
active, as shown on the next page.



enon OLIGO 7 Customer Registration

Welcome to OLIGO 7 Primer Analysis Software. In order to protect your program
license, and provide you with prompt technical support, please complete this
customer registration form and click "Register” button. If you are not connected
to the Internet, please Print and fax this formto +1 719 684 7989. After this,
you may Exit Oligo, and when you receive the Access Code back from us, you

N\ may re-start Oligo, enter the Code and click the “Confirm Code" button.
The registration would then be completed for this particular computer.

Principal Investigator or Manager's Name:
Mark Brown

Institution and Department:
State University

| Address:
Dept. of Molecular Biology
4321 Campus Dr.

FCB 556
Phone Number: Ext.: Fax Number: E-Mail:
123 456 7890 123 456 7891 mb@su.edu
License #: Workstation Code: Access Code:
7-1001 8729 5978 5949
(printSetup ) Exit )( Print )( Save )( Register ) Confirm Code

If you’re connected to the Internet, click the “Register” button at this point.
The registration e-mail is sent to MBI automatically, and upon its completion
the window should display the message “Registration form successfully
sent”. If you perform the registration during the MBI's normal operation hours
(Monday through Friday, h: 8-16, Mountain Time), expct the returning Access
Code within an hour. Otherwise, you may Exit the Oligo and start it again at
later time, when you’d receive the Access Code. Click the “OK” button to
exit.

3a. If you’re not connected to Internet, or your network does not permit e-mails
directly from Oligo, please print out the Registration Form by clicking the
Print button, and fax it to MBI at +1 719 684 7989, or press the Save button,
and the saved (text) file attach to your e-mail and send it to us.

4. When you receive the Access Code from MBI, go back to the registration
window by bringing it to the front or by re-starting Oligo, enter it to the
“Access Code” box, and click the “Confirm Code” button. The registration
process is complete.

To register your second and following computers, you need to complete the
same registration process each time.

Note: If you ever need to re-load OLIGO, contact MBI for assistance, preferably by e-
mail to mbisupport@oligo.net



2. File Opening and Viewing

The tutorials in this section give you an opportunity to learn how the features of
the OLIGO software can assist you in your research. Some of the tutorial
examples are intended to provide a general guide from which you can construct
your specific application. Others are specific, so that you can duplicate, if you
wish, similar results (similar, not exact, because future revisions of the software
may be slightly different in default parameters).

Note: if you want to duplicate the results in the search examples, open Human
elF-4E.seq for your sequence file. It is located in the Oligo 7 folder i Test
sequences subfolder. Oligo example database is in Oligo 7 folder (universal
primers.odb).

2.1. Open a sequence file

Oligo opens variety of file types, such as DNA, RNA, protein sequences,
databases and other.

1. Choose File - Open from the File menu.

2. Navigate to the "Test sequences" folder by clicking at the bar displayed at the top of the
window.

3. At he bottom of this window you may choose a file format available to you. The default is
"Nucleic Acid", so that the DNA and RNA sequence files can be opened instantly by clicking
on the "Open" button. However, when you click on the "Nucleic Acid" pull down menu, you'l

get this,
[ = -
enNe Open File
Test sequences 4
Previewer Name 4| Date Modified
ACCESSION AY436640 # BRCAZ gene.seq Monday, March 10, 2008 9:5... *
PEATURES Location/Qualif ¥ Chicken elF-4E.seq Monday, March 3, 2008 4:00 ... T
source 1..86101 # Chimpanzee elF-4E.seq Monday, March 3, 2008 3:54 .., m
ge;rinl'22'4f1825211691411 16 # Chimpanzee similar to elF... Monday, March 3, 2008 3:56 ...
mi oin ¥
5__2271{4821__505310820__ # Cow elF-4E.seq Monday, March 3, 2008 3:33 ...
10928,11846..11855,11987 # Dicyostelium discoideum ... Monday, March 3, 2008 3:19 ... |
ﬁ # Human elF-4E gene.seq Monday, March 3, 2008 4:07 ... *
il £ Y
File Format: [P
Protein
Oligonucleotide Database Bancel ) -U'D!Tr
OLIGO Search Result |

P
Saved Work File

All Files
so you'll be able to choose any of the four types of files. If you choose "All Files" Oligo will
try to determine automatically the file format, but of course you'd need to know the file type
by yourself.

4. Clicking on "Protein" and than choosing "Human elF-4E.ami" file would open this protein file
and automatically reverse-translate it to DNA. The default reverse translation method is
Lathe (choosing most probable codons for human proteins), but if before opening a protein
file you would "Change - Rev. Translate Method" to "Degenerate", you would end up with an
entirely different DNA sequence - this time a degenerate one. Please do so.

5. When you open a protein sequence file in a degenerate mode, you'll see lots of degenerate
nucleotide symbols in the Sequence window, but the translation will not look exactly like the
original amino acid file because some degenerate symbols would cover more than one
amino acid kind. Instead of arginine symbol, "R", for example, you will get low case "r"




indicating that arginine is most likely, but also that some other amino acid ma exist at certain
position.

6. Choose "Melting Temperature Graph" from the Analyze menu.
7. Click at the "graph" ( @) button and choose "Degeneracy". You should get this window:
8ene Degeneracy

File: Human elF-4E.amil2]

E. BE5lnt; 21-mers pos: 136 Degeneracy: 54
120 7

RAAYMGNTGGGCNY TN GGT TV T T YAARAAY GAY AARWSMAARACNT GGLARGCHAAYYTRMGNYTNATH
> — <l
At this point the scale displays degeneracy. Those numbers are usually high for a default
size of Current Oligo of 21 bases. To get more manageable degeneracy change the Current
Oligo length, using the Change menu, to 17. At this time you should be able to find oligos
with relatively low degeneracy.
Click on the Analyze menu. Note that in place of former "Melting Temperature Graph" item
you'd find "Degeneracy Graph". You may change the display back to tm analogously as
described in point 7.

2.2. Open a database file.

—_

N

Choose File - Open from the File menu.
Choose "Oligonucleotide Database" as File Format.

3. The "Test sequences" folder doesn't have any database files, so all the files are greyed-out.
Go up one folder higher by choosing Oligo 7 folder form the top menu.
4. Open "universal primers.odb”. You should see the database window:
Wz XaXa) Oligonucleotide Database
File: universal primers.odb
2 | 4 E # of Records: 18
‘T Date D Nurmber Sequence 3'-Dim. &G PE /pe. Tm fty,
a 1 07/13/94 X02513.6309L19 GOTTTTCCCAGTCACGACG =55 (D - 482 - |57.8 &
O 2 07713/94 X02513:6290L17 CTAAAACCACCCCCACT -12 |SC| - 479 - 540 v
a 3 07/13/94 X02513:6209U16 AACACCTATCGACCATC -4.0 o] - 381 - | 48.7 m
O 4 07/13/94 X52330:670U17 CCAGCTCCACGOTATCG -95 D - 453 - 557
O 5 07713794 X52330:720L17 TCTACAACTACTCCATC -3.7 (D - 376 - 448
a 6 08/12/94 X52330:774L17 ATTAACCCTCACTAAAG -19 |SC - 369 - | 437
O 7 08/12/94 X52330:633U21 ACTCACTATACGCCCAATTCG - sC| - 504 - |56.4 i
a 8 08/12/94 X52330:779L18 CCCCGCAATTAACCCTCAC - sC - 516 - | 56.0 v
This database is linked to Human elF-4E.seg 5 y
5. Click on record #3. From the table you can read that it forms a 3'-dimer of 4 kcal/mole, and

6.

7.

that this value is above the parameters threshold (to change the thresholds you'd have to
use "Options" button).

To see the actual dimer go to the Analyze menu (database has a different Analyze menu)
and choose "Duplex Formation". When you check this window you may close it.

The database has a powerful multiplexing option. Click on "Analyze - Multiplex All -
Minimize Reaction #". Oligo automatically finds compatible oligo sets among the entries
labeled "SC", that stands for Self-Compatible. You may view those sets by clicking on the
triangles located at the lower right:



4 el )4/ Group:l/3

26910
The example above shows Group 1, consisting of oligos # 2,6,9, and 10 in the database. All
those four oligos do not form 3'-end dimers among themselves.

8. Let's make a new set of primers in the database. From the Edit menu choose "Add Set".
The lower part of the window changes and shows four edit boxes, under "Enter Record #'s".

9. Enter to the Forward Primer box "9" and to Reverse enter "10". The "Add" button activates.

10 Click the "Add" button, followed by "Show All" button.

11. You should see a new row added to the database. If the window is not tall enough, use the
slider (a dot separating individual oligo entries from sets), and drag it up.

12. Close the Database window without saving.

3. Navigating in Oligo

Note: if you want to duplicate the results in the search examples, open Human
elF-4E.seq for your sequence file.

3.1. Moving around a sequence file.

After the registration, described in the User Manual, Chapter 2.3, you may open
a sequence file or a database. This example describes how to move around and
what features are immediately available to you after opening a sequence file.

1. Open a sequence file: use File-Open, and in the "Test sequences" Folder choose Human

elF-4E.seq. Click on the "CDS" row displayed at the top right of the window. You should
see the Sequence window, as depicted on the figure below:

806 Sequence
File: Human elF-4E.seq
DNA Sequence Selected Oligp  Position Length # Feature Location
Sequence Length: 1868 nt O Forward Primer — —_— 1 source -18..1850
Reading Frame +1 O Reverse Primer — — 2 CDS 1.651
Current Oligo Length: 21l nt O Upper Oligo
Position: -18 [ Lower Oligo - —
o Tt 52.0°C PCR Product [-—-——-Int

i 100 200 (360 40 |00 e R 800 (8001000 (1108 1208 1300 1400 1500 1600 1700

CGATCAGATCGATCTAAGATGGCGACTGTCOAACCGGAAACCACCCCTACTCCTAATCCCCCGACTACAGAAGAGGAGAAAACGRAATCTAATCAGGAGGTT!

GCTAGTCTAGCTAGATTCTACCGCTGACAGCTTGLCCTTTGETGGGGATCAGGATTAGGGGGCTCATGTCTTCTCCTC GCCTTAGATTAGTCCTCCAACGATTGGGTCTTGTGA

GCTAACCCAGAACAC

RS DRSKMA2TVYEPETTPTPNPPTTETETEIKTES SN GQEWVANFPEH.Y

«» 3 ralel s
Clicking on "CDS" highlighted the coding region of elF-4E DNA sequence (it is actually the

mMRNA sequence reverse transcribed to DNA)

2. Move the horizontal bar. You will notice that the yellow-shaded box moves around the Tm
graph. Sequence in this box is displayed at the bottom of this window. Click on any
nucleotide displayed this window - you just changed the Current Oligo position. All the
features of the Sequence window are described in the Manual, Chapter 2.5. You may move
down or up the sequence using the keyboard (arrows, page up or down).




. Keep the Sequence window opened, and choose "Open Reading Frames" from the Analyze

menu. If you click on any nucleotide position you also change the Current Oligo position:
observe the Sequence window while playing with the ORF window. You may change the
reading frame just by clicking on the open reading frames displayed in the top portion of the
ORF window.

Close the ORF window (for clarity) and open the Melting Temperature Graph and/or Internal
Stability - Current Oligo windows from the Analyze menu. Note that by clicking on the
nucleotide symbols or the graph itself you are actually moving to the new positions. If you
zoom out the Tm window, by clicking on the loupe symbol with "-" sign, you still can change
the Current Oligo position by clicking on the graph.

Close all but the Sequence window and choose "Selected Bases" from the Search menu.
You will see 4 columns there. "Loops" (showing strong stems of the sequence) and
"Strings" columns are empty, because you haven't searched yet for the strings, and there
are no strong stems (below -12 kcal/mol: a default search parameter setting for "Template
Loop AG Threshold" with the "Template Loop Window Size" of 40 nt.) in this DNA sequence
file. Columns (Hairpin loop) "Stems" and "Palindromes" are filled with numbers, as those
searches are initiated automatically as soon as you open a sequence file. By clicking on any
of those numbers you change the Current Oligo position.

. Another method to change the Current Oligo position is to open the "Select New Current

Oligo Position" from the Select menu and entering the desired position number.

Make a quick search for Sequencing Primers (Search -> for Primers & Probes...-> click
"Sequencing Primers" followed by "Search" buttons). After the search you'll see the Analyze
-> Selected Oligonucleotides window. You may also select the Current Oligo by clicking on
any row displaying Forward or Reverse Primers. By double clicking on these primers in the
Selected Oligonucleotides window you will not only change the Current Oligo position, but
also you will select the actual primer (observe the Sequence window how it changes).

3.2. Changing windows appearance

The display of certain windows can be customized. The Edit windows, for
example have two display modes, as well as all the Analyze windows with the
"Options" @ button.

1. Open the Edit - Entire Sequence window. You should get the "Full Screen Edit" window.
2. This window has its own menu. Click on Edit item. You should see the following menu:

806 Edit Sequence

File: Human elF-4E.seq

Accept;Dlscard I!ﬂl Search Change RevTransIate
£ Can'tUndo #2Z ..

18 10 |5 pos
b 4 Can't Redo {+3Z -

-18 COATCAGATC GA - CCACCCCTAC TCCTAATCCC

3 CCoACTACAG an o0 CUT X TTGCTAACCC AGAACACTAT 3
183 ATTAAACATC cC 93 Co Py #C TTAMAAATGA TARAAGCAAA
163 ACTTGECAAG (A J) pasre gy CTGTTGAAGA CTTTTGGECT m
223 CTGTACAACC AT . GCTGTGACTA CTCACTTTTT
283 acoateera 11 Il Clear AACGGGGAGG ACGATGECTA
343 | ATTACATTGA AC GCTTTTGGCT AGAGACACTT
43 CTeTeccTTA TT - Select All HA ATGTATGTGG CGCTGTTGTT
463 AATGTTAGAG CT CTGAATGTGA AAACAGAGAA
523 GLTGTTACAC AT Merge with P GACTTCCTCC AMAGATAGTG -
583 ATTGETTATC AG ey by y GETCCACCAC TAAAAATAGG i

643 | TTTGTIGTIT A4 7 - AGACTGCGTC AAGCAATCGA v
verwrite NS[DNA

Clipboard is empty.

< Sound On
Readback On

@ Full Screen Edit
Mutagenesis

® Nucleic Acid
Protein

3. Note a dot by the "Full Screen Edit". It indicates the current window style.
4. Click on the "Mutagenesis" item. The window changes its appearance (see the following

10

figure). If you'd be editing a primer, this type of window would open automatically.



re 06 Edit Sequence

File: Human elF-4E.seq
Accept/Discard Edit Search Change Rewv.Translate

sT (v [fml@ld]2|e] Q<] pos:[ 1
Sequence Length: 1868 nt| |ty 76.7 °C
Reading Frame: 1 fule} -96.9 kcal/mol
Cegeneracy: L Loop Ty 54.5 °C
Loop AC: -2.1 kecal/mal

RT. Method: Lathe

Codons for Arginine

AGA AGG CCA CGC CGG (any
10.9 1L1 6.0 110 LL4 4.7

T T R - L P 149
[CGA TCA GAT CGA TCT AAG ATG GCG ACT GTC GAA CCG GAA ACC ACC CCT ACT CCT AAT CCC |
R s D R 5 K M A T ¥ E P E T T P T P N P

<« B 14l

3 CCCTAATCCTCATCCCCACCAAAGGCCAAGCTOTCAGCGOTAGAATCTA
Clipboard is empty. | INS | DNA 2

5. Close the Edit window and open the Melting Temperature window.
6. Click on the "Options" button. You should see this:

e
8eoe Melting Temperature
File: Human elF-4E.seq

@l E @ 1868nt; 21-mers pos: l— tm: l—
., e

40 |

66.0- '+ Show Mean Value Bars

g‘z‘g: v Show Threshold Values =

60.0- . W 'b o 7 45 Dots o,

B o

58.0° f ] (
56.0- W%em be ST Qe 8
5402 ¢ o 57 0
52.0-eq. L)
50.0-

48.07

46.0-

44.0-

42.07

40.07

COATCAGATCOATCTAAGATGGCLACTGTCOAACCGLAMACCACCCCTACTCCTAATCCCCCGACTACE
«»r B yalel 4
7. Click on the "Bars". Now the T,s of the oligos is displayed as bars instead of dots. This

type of change is available on Internal Stability and Sequence Frequency windows as well.
8. Click on the small graph icon ( @). You should see this menu:

e
en0e Melting Temperature
File: Human elF-4E.seq
L} E 42| 1868nt; 21-mers pos: tm;

—L“%.......|1.°........|2.°........|3.°........|“:°........|5.

66.0- L Tm(+) I

6407 Trm(_ 20

62.0° e la("% o e f 2 n

s0.0-0 O Ag L 8 9 8y o By

58.02 I AG(+) L _-e\eee_ 8 &

56.0- el o ' )

sapd T AG(-) 'y 97 B¢

52.048 GC% L @

50.0+

2301 Degeneracy

46.0-

44.02

42.02

40.02

COATCAGATCGATCTAAGAT GG CCACTOTCGAACCGGASACCACCCCTACTCCTAATCCCCCGACTALS

« 6 P 4

At this point you may choose a different kind of Current Oligos representation. The default
was "tm", showing melting temperature graph of oligos without dangling ends. Tm(+) shows
the same but with the dangling ends, and Tm(-) shows T, with dangling ends of oligo
complements. Similarly, "AG(+)" and "AG(-)" shows free energy graph with dangling ends of
Current Oligos and their complements, respectively, while "Ag" represents the standard
values, without the dangling ends. "CG%" shows the CG content, and Degeneracy (active
when the sequence is degenerate) shows the number of possible sequence combinations.

11



9. Close the Melting Temperature window and open the Open Reading Frames window. When
you click the "Options" button, you'll be able to change

Min. ORF Size: 1 aa

(oG] I8 le Aminoacid Type i
] Codon Frequency ' il
the meaning of open reading frames color coding from amino acid type to codon frequency.
10. Note a slide button at the top left of the ORF window: & O———— &
By dragging it to the right you'll see zooming in the ORF graph. This feature is very useful
when the opened sequence is large.

4. Search for Primers and Probes

This section describes methods in searching primers and probes, the "Search -
for Primers & Probes..." menu item.

=

enn Search for Primers & Probes

[ Search Options | Subsearches ]

6 Search 3
Search in: # + Strand ™ - Strand —
Search Mode: ® Sglect Verify (_Cancel )
( Apply )
@ Complex Substrate
PCR Primers:
f*) Compatible Pairs
C Nested Primers
Compatible with the Forward Primer
Compatible with the Reverse Primer
) TagMan Probes & PCR Pairs
) Molecular Beacons & PCR Pairs
C Sequencing Primers
/: Hybridization Probes ) i
siRNA Probes | Parameters |
) |" Ranges ',I
After successfull search show: _All Results ﬂ -
(" Defaults )

Take a quick look at the Search for Primers dialog window. At the top you see
two tabs, Search Options and Subsearches. Below this there are two check
boxes - if both checked the search will proceed in both DNA strands. The
Search Mode is set to "Select", that is, the search will start from scratch, and not
continue on already selected primers (that's the "Verify" mode). If you uncheck
the "Complex Substrate" box, good when working with plasmids, not with total
organism DNA, a sub-search to eliminate frequent oligos will not take place.
Below this box, you see a list of possible search types that Oligo can perform.
Buttons on the right: the "Search" button starts the actual search, "Cancel" closes
the window, and "Apply" memorizes the current type of search, so that when you
"Cancel" the window and come back to it you'd see the most recent setting.
"Apply" also sets the search parameters and accordingly, modifies the Sequence
and other relevant windows. Button "Parameters" opens the search parameters

12



windows, including windows that define the stringencies and scoring system.
Button "Ranges" opens a complex dialog that controls not only the search
ranges, but the number of results you need within the ranges. Button "Defaults"
changes all parameters to the default values. This chapter will guide you through
various search types.

4.1. Searching for PCR primers, a simple search

This example takes you through a quick search for a pair of optimal PCR
primers. To run this search, open Human elF-4E.seq file and:

1. Choose the "Primers and Probes" option from the "Search" menu.

2.
3.

4.

9.

Verify that the "Compatible Pairs" button under "PCR Primers" in the dialog box is checked.
Click "Search" to start the search. The "Search Status" progress window appears, and the
message "Search Completed" appears when the search is complete.

When the search is complete, two windows open: "Oligonucleotide Sets" and "Selected
Oligonucleotides". You may also check the "Primers & Probes Search Data" (from the
Search menu) window to make sure that the final search stringency is acceptable. OLIGO
automatically reduces search stringency if it does not find any compatible pairs.

. There are six sort options on the "Oligonucleotide Sets" and "Selected Oligonucleotides"

windows. The sort order is indicated in the figure below by red arrows:

(SN NS Oligonucleotide Sets
File: Human elF-4E.seq
Forward Reverse
Product Opt.
# Prir;e Prirzn/ Scolr/ Length T %CC
1 59 332 932 294 525 40.5
2 101 336 920 256 516 39.8

ca7 1742 alao 1178 3

You may change the sort order by simply clicking at the column name. Option-click (or Alt-
click) allows for multiple sorts. You may also sort the data by product length or any other
field not sorted in the example above.

Click on a primer pair to select this primer pair or double click on a pair to view the "PCR"
window for the selected pair.

274

10. Choose the primers from the Analyze - Key Info menu or other Analyze menu windows to

view the primer sequence and/or related data.

4.2. Searching for PCR primers, an example to show the options

1. Choose the "Primers and Probes" option from the "Search" menu.

2.
3.

Verify that the "Compatible Pairs" button under "PCR Primers" in the dialog box is checked.
Click the "Parameters" button. At this point you see the General Parameters, as indicated at
the top of the window:

(&) Search Parameters

[ Parameters Sequence Constraints Scores |

{General | Constraints ~ More Constraints |
This will let you change the search stringency globally, change sequence frequency table
and salt and primers concentration in the reaction mix. By default, the stringency search is
set to "High". If you experience a long search time, you may shorten the search by starting
from a lower stringency type. Otherwise, Oligo will reduce the stringency automatically if
needed, as long as the "Automatically change stringency" box is checked:

\ Search Stringency: High F

E Automatically change stringency

Choose the "Fair" search stringency.

. Check the "Constraints" and "More Constraints" options. Each sub-search option that will be

active for a given search method has a blue dot on the left. The irrelevant sub-searches

13



have no blue dots. To the right of this dot you should see an open or closed lock. This
represents whether a given parameter can be changed during automatic stringency search.
You may wish to permanently fix a specific parameter to the displayed value by clicking on
an open lock. The lock should close. Some parameters Oligo is not able to change
automatically. These sub-searches are labeled with grey-out locks. The image below
shows one of the sub-searches in the "More Constraints" window

= @ Template Loop AC Threshold: -20.0 kcal/maol

This is active parameter for Compatible Pairs search (blue dot on the left) and the automatic
stringency may change it, if necessary. For sake of this example, increase this value to -6
kcal/mol and lock this value, and click "OK". You've just set the parameter of a sub-search
that will eliminate all the PCR products (not the primers!) that would make a hairpin with a
AG larger than -6 kcal/mol, with the size of this hairpin not larger than 40 nt. (if the "Template
Loop Window Size" was set to 40 nt). Note that this test sequence has only one loop like
this around pos. 160-200 (Sequence window marks it in maroon color).

6. Click the "Ranges" button. Instead choosing the search ranges manually, click the "Check
Region(s)" button.

7. From the "Features" window select the #2: CDS (coding sequence), so you should see this:

enNne Features

# Feature Location
O 1 |source -18..1850
™ 2 CDSs 1.651

and click the "Accept" button.

8. Check the "Find products in checked region(s) only" box.

9. Check also the box "No multiple products in one sequence region" and "Cover the entire
search area with" "Overlapping products".

10. Change the PCR product length to "150 to 300".

11. Click the "OK" button. You should get just the coding region covered with PCR products,
and the hairpin loop in the template gone from any PCR products.

4.3. Searching for sequencing primers

. Choose the "Primers and Probes" option from the "Search" menu.
. Click on "Sequencing Primers" button
. Choose the DNA strand the primers should be made of: leave checked "Search in: + Strand"
if you want primers to sequence forward (they would be annealing to the negative strand),
and uncheck the "- Strand".
4. Choose the region you want the primers located: click the "Ranges" button and type
"Positive strand search range:" 400 to 450. The negative strand search range is irrelevant.
5. Make sure the "No overlapping primers/probes" box is checked if you want to avoid multiple
choices of almost identical primers.
6. Click "OK" button.
7. Click the "Search" button. You should get only one primer in the "Selected Oligonucleotides"
window.
8. Double click on this primer in the "Selected Oligonucleotides" window. You've just selected
a sequencing primer.

wWnN =

4.4. Searching for consensus hybridization probes

1. Choose the "Primers and Probes" option from the "Search" menu.

2. Click on the "Hybridization Probes" button

3. Click on the "Subsearches" tab at the top of the window.

4. Click on the "Consensus Probes" box at the bottom of the window. A new window "Select
Files" pops out, and you need to select other homologous sequences.
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5.

6.

8.

9.

Click the "Add" button and navigate to the Test sequences folder, supplied with the software
(by default it is located in the Oligo 7 folder in the Applications folder).
Choose the files as shown on the image below:

r FaY n |
8eNnse Select Files
File Sets:
Select Set
Remowve Set
Search in:
/Files /Oligo 7 folder/Test sequences/Chimpanzee elF-4E.seq [ Add b
JFiles fOligo 7 folder /Test sequences /Cow elF-4E.5eq —
fFiles fOligo 7 folder/Test sequences/Mouse elF-4E.seq Remove
fFiles/Oligo 7 folder/Test sequences/Rabbit elF-4E.seq
fFiles fOligo 7 folder/Test sequences/Rat elF-4E.seq Save Set

(" Cancel -,I (—BI(—)

by repetitively clicking on a file name and the "Add" button.

Click the "Done" button and return to the "Select Files" window. The window should look
similar to the one depicted above.

You may click "OK" now, but if you'd like to memorize this set so that you can use it at later
time, click the "Save Set" button and give it a descriptive but short name, than click "OK".
Go back to the "Search for Primers & Probes", and click the "Search button".

A4

10. The results are displayed in the "Selected Oligonucleotides" window. Sort it by "Oligo

Position" by clicking on the "Oligo Position" title.

11. Double click on the second oligo (pos. 57). You've just selected a non-degenerate probe.

You may check it on any relevant Analyze windows. In the top right of the Selected
Oligonucleotides window there is a check box "Select consensus oligos". If it's checked, the
selected probe would contain a few degenerate bases. This is because it is a consensus
probe. You may check the alignment by dragging up the dot located at the bottom center of
the "Selected Oligonucleotides" window, see below:

.
806 Selected Oligonucleotides
File: Human elF-4E.5eq

Upper Oligos |5 } 14 : Select consensus oligos

-

Cligo 3'-Pentamer  GC Clamp
# Position Length Score Tm AG A
1 19 24 928 71.1 -6.8 -7.9 A
2 57 2? 867 71.4 -6.9 =7.5 ¥
].?3 3 74.9 -6.3 -9.6
the (/ e —
Oligo % t, [*Cl Degeneracy
File 1: 57U27 GGAGAAARCGGAATCTAATCAGGAGGT 100 70.7 1
File 2: 67U27 GGAGAAARCGGAATCTRATCAGGAGET 100 70.7 1
File 3: 71U27 AGAGAAAACAGAATCTAATCAGGAGGT 93 68.1 1
File 4: 76U27 GGAAAAARCAGAGTCTRATCAGGAGET 89 £9.2 1
File 5: 58U27 GGAGAAARCAGACTCTAATCAGGAGET 93 70.2 1
File 6: 105U27 GGAAAAARCAGAGTCTARATCAGGAGGT 89 £9.2 1
Consensus 5' RGARAAAACRGARTCTAATCAGGAGGT 89- 100  68.1-70.7 16

Analyzed files: 1. Human elF-4E.seq

2. Chimpanzee elF-4E.seq
3. CowelF-4E.seq

4. Mouse elF-4E.seq

5. Rabhit elF-4E.seq

G

. Rat elF-4E.seq

4
Note that the mismatches with the File 1 (the principal sequence) are marked in red.
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4.5. Searching for TagMan Probes & PCR Pairs

—_

. Choose the "Primers and Probes" option from the "Search" menu.

Click the " TagMan Probes & PCR Pairs" button.

. Click the "Search" button. The sets are found and displayed in the "Oligonucleotide Sets"

Table.

Click once on a set to select it, or click twice to choose it and open the PCR analysis window
at the same time.

If you don't like the default Tm difference between the primers & the probe, before the
search you may alter it by changing the "Tm of Probe - Tm of Primer" search parameter in
the "Constraints" window.

If you need only a specific DNA region to work with, before the search you may set the
search range by choosing it from the "Search Ranges" window (click the "Ranges" button
and enter the positive and negative strand search range in the top of the window, following
by the "OK" button).

4.6. Searching for Molecular Beacons & PCR Pairs

N —

. Choose the "Primers and Probes" option from the "Search" menu.

Click the " Molecular Beacons & PCR Pairs" button.
Click the "Search" button. The sets are found and displayed in the "Oligonucleotide Sets"
Table.

Double click on a set to select it and open the PCR analysis window at the same time. Note
that you get a seemingly disturbing comments "The Upper Oligo does not match the
template" and "3'-end Upper Oligo dimer". This is a sign that the beacon probe was
selected successfully.

To see the alignment with the template choose the Sequence window and move the
horizontal scroll bar to see the probe:

'6 06 Sequence

File: Human elF-4E.seq

DNA Sequence Selected Oligp ~ Position Length # Feature Location
Sequence Length: 1868 nt| J[i) @ |Forward Primer 216 19 1 source -18..1850
Reading Frame: +1 Ji) @ Reverse Primer 295 21 2 CDS 1.651
Current Oligo Length: 2lnt| [ @  Upper Oligo 243 30
Position: 213 | Lower Oligo —— ——
) Tt 57.6°C | JD PCR Product [100,---] nt
11 (00200 (360 e60 \500 Ll \700 |500 fiele) (1000 1100 1200 1300 1400 1500 (1600 1700

! .;'¢E_E.~‘ll: AAGGATGOTATTCAGCCTATOTOOGAAGATGAGAAAN
GAAAACCCGAGACATGTTGLTATAGGTCAACAGATCATTAAATTACGLACCCACACTGATGAGTCAARAATTCCTACCATAACTCGGATACACCCTTCTACTC

1 CTCGLATACACCCTTCTACTC
F " ALYNHIOQLSSNLMPGLOCDYS5SLFEKDGSGTIEFPMM®WETDE KN

<« -—-) E Ry

6. View the probe under various Analyze windows, especially Analyze - Hairpin Formation -
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4.7. Searching for siRNA Probes

A

© NN

Open Human elF-4E.seq.

Choose "DNA to RNA" from the "Change" menu.

Choose the "Primers and Probes" option from the "Search" menu.

Click the " siRNA Probes" button.

Click the "Search" button. The oligos are found and displayed in the "Selected
Oligonucleotides" Table.

Double click on the first record. You've selected the sense strand of a siRNA probe.
Choose "Lower Oligos" from the pull down menu (top left of the window).

Double click on the first record. You've selected the antisense strand of a siRNA probe.
Check the Internal Stability window ("Analyze"- "Internal Stability" - "Lower Oligo"). It should
like similar to this one:

® O O Lower Oligo Internal Stability
File: Human elF-4E.5eq

19nt; [3'-end]: 92 pos: 11 Ag: 10.0

ESTTEETTN L, SR L. SNTTTTTIL L SURTEE

-14.0-
-13.0-
-12.0-
-11.04
-10.0- &
-B.D—_ -] .'e,e-&e
-8.0- @
-7.0-% @

- &
-E.D—_ 1 ee&
-5.0- &

UGUUUAALAUAGLGULCUG

The negative strand probe (always a 19-mer) should start from a pentamer of -7.5 kcal/mol
or so, its 3'-end should be slightly more stable than 5'-end, the internal 12-mer stability
should be about -22 kcal/mol, should not form significant internal hairpin loops, should not
have sequence repeats, and should be as unique as standard hybridization probes.

. Add manually TT or attach dinucleotides corresponding to the original mRNA to the 3'-ends

of the oligos: use "Edit" - "Upper (Lower) Oligo" options. The dTdT is preferred for a better
probe stability.

4.8. Searching multiple files (batch processing)

ok~

Start Oligo and choose "Search" - "Sequence files".

Select files: choose the entire Test sequences folder.

Choose the Method of search: Hybridization Probes.

Click the "Ranges" button and check the "Choose hybridization probes every" "1000 bp".
Click "OK", and another "OK" to get back to the "Batch Processing" window.

Click the "Search" button. Before Oligo starts searching it asks you for a file name for the
results data. Default is "BatchResults.txt", a plain text file. Enter a new name or leave it as
is. Note that you may save the file in three different formats: Simple List, Full Analysis or
Oligonucleotide Database. Accept the name by clicking at the 'Save" button.

. The Search Progress window displays how many files were processed and scheduled. The

search ends when this progress window disappears. Open the BatchResults.txt file with any
word processor.
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5. Other Search Options

5.1. Search for a sequence string

Oligo's search for string is not just a plain 'Find' function commonly implemented
in most editing software. It allows searching for mismatches and for ambiguous
bases. This example shows the process.

1. Start Oligo, open Human elF-4E.seq and choose "Search" - "for a Sequence String +
strand".

2. Type a degenerate sequence CAYNNNNRTG. It's an Msl I recognition site and click the
"Find" button.

& 7 String Search in [+] strand

_Sequence String:
CAYNNNNRTC

Allow 0 mismatches

E Translate ambiguous bases:

K(GT) M(AC) R(AG) S(CG) W(AT) Y(CT)
B(not A) D{not C} H(not G} V{not T) INX(any}

( Cancel ) @

3. The results pop up in the "Selected Bases" window in the "Strings" column. Click the last
position (1813). You should see the following window:
®0 6 Selected Bases

File: Human elF-4E.seq
P String search results

Loops Stems Palindromes Strings
18 Fy =13 'y 398
17 v 12 v 766
16 m 11 m 902
-15 -10 1285
-14 -9 1417
-11 i -8 H 1813
10 v 7
1] 512 156 6

A4
The pos. 1813 is highlighted. At the same time the Current Oligo pos. 1813 is selected and you

can see this in the Sequence window:

i1 |10 \260 300 (860 (560 soo \700 \460 1] (10081108 1200 1300 (1400 1500 1600 1700

CATATATAT
CATATATATG

TaTGAACAGC ATAAGT T TG GAGCACTAGT T TGATTAT TATGT T TATTACAAT T T TTAATAAATTGAATAGOTAGTATCATATATATGGAAAAAAAAAAAARARAAAAAARAARAN
ACACTTGTCGTATTCAAACCTCGTGATCAAACTAATAATACAAATAATCTTAAAAATTATTTAACTTATCCATCATAGTATATATACC TTITTTTITTITTITITTITTITT

The arrows point to pos. 1813, marked in orange. This position is at the beginning of a 10 bp-
long palindrome (marked in green). The palindrome itself was selected as the Upper Oligo,
shown above as the top sequence in red.
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5.2. Search for restriction enzyme sites

Start Oligo, open Human elF-4E.seq and choose "Search" - "for Restriction Sites..." option.
Click the "Select Enzyme Database". The files are located in the Tables sub-folder.

Click the 5&UP.ENZ file containing most 5-cutters and higher and the "Select" button.
Choose "Linear" sequence and click the "Search" button.

. You should see the results in the "Restriction Enzyme Sites" Analyze window:

6006 Restriction Enzyme Sites
File: Human elF-4E.seq

A

# Enzyme 1L (180 20 300 (260 500600 |FUQ B0O 800 (1000 1100 ,m:lu. (1300 1400 1500 1600 1700

68 Mphll03l | | i
69 Msel Il | | | ] 1] I
70 Ml | I - |

71 Mval269 |

72 | Nsil | |

73 Ppulol | |

74 Puul

75 Saudl

76 Sdul

77 SfaNl - | [I]
78  Sfcl | | ]
79 Spel |

# Enzyrme Site #Cuts Positions & Fragment Sizes
£1l1 L3I0 ou

70 Msll CAYNNANNRTC 1 415 398 368 766 136 902 383 1285 132 1417
396 1813 37

71 Mval268] GCAATGC(1/-1) 1 1331 1314 536

72 Nsil ATGCAAT 2 1057 1080 290 1370 480

73 PpulOl ANTGCAT 2 1097 1080 290 1370 480

74 Pvul CCATALCG 1 395 378 1472

75 5au9el GAGNCC 1 934 917 933 m
76 5dul GDGCHAC 3 145 128 90 218 1537 1755 95

77 SfaNI GCATC(5/9) 1 1086 1079 771 .
78 Sfcl CATRYAC 3 64 47 68 115 317 432 1418 L4

Search: Entire Sequence (Linear) Restriction Enzyme Database: S&UP.ENZ
This window consists of two parts. The top one is a graphical representation: the entire row
represents the length of the sequence file and the blue vertical lines are the recognition
sites. The bottom part is the enzyme listing, ended at the bottom with a list of non-cutting
enzymes (scroll the bar down to see it: the picture above does not show it). The actual
recognition sites are listed in black, and the fragment sizes are in green.

5.3. Search for restriction enzyme sites in protein

This search reverse-translates a protein sequence into all combinations of
reading frames and finds all possible restriction enzyme sites that could be
made. This feature is useful in gene construction projects. The example below
shows how to find a protein of interest, set the proper reading frame and then
find the restriction sites only in this protein.

1. Start Oligo, open BRCA gene.seq and open the Open Reading Frames window from the
Analyze menu.

2. Find the longest pen reading frame in the sequence. This is the one we'd like to analyze for
potential restriction enzyme sites. Click on the graphical representation of it to set the proper
reading frame (see the graph below). You may use the zoom-in slider located at the top left
of the window for a better view.
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Open Reading Frames

e R YA U BBl T L A P -
N A A e

RF Stariscs ‘Codany coared by frequency (highest on left)
, o

[ onn Wialetals Weight
1+2] 22454 - 27004 50738 LM2LA

ana

Fle BELAT gt vt
.l

2

3

The zoom-in slider I KL TR T
111N N TN 0B R I |
Wir fnrem AT AU T R T

When you click on this ORF it gets underlined in green and TTTR T TR
the information about this particular protein is shown in the TRRIT N TN

({1
: LI nmn
ORS Statistics table. [ (M W

This green rectangle shows what part of the sequence
is displayed in the lower part of the window (zoomed-in
area). Move the seroll bar to see other regions.

ORF Statistics

R.Fr. Position Protein Molecular Weight Mean pKa
[+2] 22454 - 27004 1517 aa 170223.0 7.1l

3. Choose "Search" - "for Restriction Sites in Protein..." option. It should indicate Reading
Frame 2.

@ ) Search for Restriction Sites in Protein

rSearch:

) Sequence Reading Frame: (2 %

@ Pportion Start: 22454  End: 27004

rEnd Cut Type:
8 Blunt 8 3'-overhang
8 Odd 8 5'-overhang

rLimit:

E Limit the number of sites

Maximum # of restriction sites: 5000

( Cancel ) @

4. Type in the Start and End position numbers of the protein. You should find those numbers in
the ORF window.

5. Click the "Search" button, if you want to find all possible enzyme "Cut Types".

806 Restriction Enzyme Sites in Protein
File: BRCAZ gene.seq

#oakpzyme  ooug (23000 23500 (22000 (24500 25000 25500 2u000 (26500 i
[RELaLET (- (N [ (- (- 'y
55 Pvul [ | | £
56 vl 1 I B B B \ \
57 Rleal 1 | [— \ \
sssad [ [ [l | [— I [ —
53 sacl | (1 [— | |
50 sai M | I 0
61 Saol | | - | I I
52 saal | 1 [ 0 Y I
63 Smal | | | v
#  Enzyme Site #Cuts Positions & Fragment Sizes
68 Spll RT3VRWYS 4 21775 23132 1409 24541 1663 26204 159 26363 23094 .
69 Sspl NILlevY? 22 22369 22538 325 22863 173 23036 135 23171 280 23451 v
102 23553 287 23840 139 23979 14 23993 198 24191 F
162 24353 54 24407 163 24570 429 24999 192 25191
696 25887 l44 26031 273 26304 111 26413 215 26630
96 26726 208 26934 22523 m
70 Stul RPLGLVA7 9 21822 23085 587 23682 118 23800 495 24295 522 24817 =
972 25789 125 25914 742 26656 144 26800 22657 rl
71 Swal I-eLFK7YLN 3 18759 26148 342 26480 19 26509 22948 M
Search: 22454 10 27004 End Cut Type: Blunt, Odd, 3'-overhang, 5'-overhang 4

6. After the search the results are displayed in a window with a very similar format to the
standard "Search for restriction enzyme sites" window, except that the degenerate protein
site is listed instead of the actual DNA recognition site sequence (all those symbols are
explained in the Appendix E of the User Manual).
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